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 Computers—Storage and Memory Device

Tech Trivia Section A (Objective)

A.	 1.	 b	 2.	 a	 3.	 c	 4.	 a
B.	 1.	 Hard Disk	 2.	 Nibble 	 3.	 Magnetic Disk		
	 4.	 ROM

Answer Arcade Section B (Subjective)

A.	 1.	 CD-ROM, CD-R, CD-RW
	 2.	� Computer memory is where data and information are kept. The Central Processing Unit 

(CPU) gets data from memory to work on it.
	 3.	 A hard disk with a magnetic coating is referred to as a magnetic disk.
B.	 1.	� Flash Drive, also known as flash storage, is a type of non-volatile memory. It is used for 

easy and fast information storage in computers, digital cameras and video game consoles.
	 2.	� Think of data as unprocessed, raw facts and figures, such as words, numbers, images, 

and symbols. Data by itself is meaningless. Once the data is processed and organised, it 
becomes information. Information gives a proper meaning.

	 3.  	 a.  Zettabyte
		  b.  Solid State Drive
		  c.  Dynamic Random Access Memory
		  d.  Read-Only Memory
C.	 1.	� Pen Drive, as a portable hard drive, offering ease of use due to its small size and portability. 

It can be carried in a pocket and plugged into any computer with a USB port.
	 2.	 2,048bytes

1.
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Higher Order Thinking Skills (HOTS)
1.	� DVD, designed for storing large files, such as High Definition (HD) movies. It can hold more 

information than a CD.

2.	 Two main types of primary memory: 

	 a.	� Random Access Memory (RAM): RAM is a temporary memory that loses its data when 
the computer is turned off. It temporarily stores the data and instructions given by the 
user, as well as the results produced by the computer. 

	 b.	� Read-only Memory (ROM): ROM is a type of permanent memory. It keeps data even 
when the computer is turned off. ROM stores the essential instructions needed to start up 
the computer.

Code Clues

	 1.	 PEN DRIVE
	 2.	 OPTICAL DISC
	 3.	 USB ARRAY DISC
	 4.	 DIGITAL VIDEO DISC

Tangible Task
Do it yourself

Digital Drills

Do it yourself

 GUI Operating System— Desktop Management

Tech Trivia Section A (Objective)

A.	 1.	 a	 2.	 c	 3.	 d	 4.	 b
B.	 1.	 c	 2.	 a	 3.	 d	 4.	 b
C.	 1.	 T	 2.	 F	 3.	 T	 4.	 T

Answer Arcade Section B (Subjective)

A.	 1.	 Sorting the icons means organising their arrangement on the desktop.

2.
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	 2.	� Right-click on the taskbar, click on Taskbar settings. Scroll down to Taskbar behaviors, click 
on down-arrow. Select Left or Center option from Taskbar alignment down-arrow.

	 3.	� The This PC icon provides access to all the files and data on your computer. It is a helpful 
tool for locating, organising, and managing your files.

B.	 1.	� You can adjust the speaker volume directly from the Taskbar. To do this, Click on the   speaker 
icon in the notification tray, then drag the slider left to decrease or right to increase the 
volume.

	 2.	 i.	 Right-click on the desktop, choose Personalize option and click on Colors option.
		  ii.	 Click on Choose your mode drop-down list and select any option you want to use.
		  iii.	 Turn On Transparency effects to have a transparent glass effect on the borders, etc.
		  iv.	 Select the desired colour from the Accent color section.
		  v.	� Scroll down and click on the toggle switch to turn ON or OFF the option to Show accent  

color on title bars and window borders.
		  vi.	� Click on Custom colors and set colour accent of your choice from Choose a custom 

accent color dialog box and click on Done button.
	 3.	� Each icon acts as a link to an item on the computer, whether it’s a program, file, folder, or 

printer, and can be located anywhere on This PC. By clicking on an icon, the associated 
program, file, or folder will open.

C.	 1.	� Click the Start button in the bottom-left corner of the screen. Type the name of the program 
in the search bar. When the program appears in the search results, click it to open.

	 2.	� Right-click on the desktop and choose Personalize option. Click on the Background. Click 
on the down arrow beside the Personalize your background option and select the Picture 
option from the drop-down list. Click on the Browse photos option. Click on the image 
you want to use from the Open dialog box. Click on the Choose picture button.

Higher Order Thinking Skills (HOTS)
1.	� Right-click on the desktop and choose Sort by option. Select any option to arrange the icons 

in that order (for example: Name).
2.	� The Pinned Apps are located on the Taskbar, offers a set of shortcuts for instant access to 

frequently used programs. This feature enables you to open your applications quickly and 
efficiently.

Code Clues

1.	 Taskbar
2.	 Windows
3.	 This PC
4.	 Start Button

Digital Drills

Do it yourself
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 Editing in Word 2021

Tech Trivia Section A (Objective)

A.	 1.	 b	 2.	 c	 3.	 b	 4.	 b	 5.	 a
B.	 1.	 Blue 	 2.	 Duplicate	 3.	 Microsoft Corporation	 4.	 Synonym
C.	 1.	 d	 2.	 c	 3.	 e	 4.	 b	 5.	 a

Answer Arcade Section B (Subjective)

A.	 1.		� Position the cursor to the right of the text and press the Backspace key. The character to 
the left of the cursor will be deleted.

	 	2.	 Any two features of Word 2021 are:
	 		  ●  type letters, stories, reports, and other documents easily.
	 		  ●  insert pictures into the document.
	 	3.	� Undo is used to reverse the last action you performed, while Redo allows you to reapply 

the action that was undone by the Undo command.
B.	 1.	 To create a new document, follow the given steps:
	 	 Step 1: Click-on the File tab.
	 	 Step 2: Select the New option.
	 	 Step 3: Click on the Blank document option.
	 2.	� Selecting Text – To modify existing text, you first need to select it. There are several ways 

to select a text using a keyboard or mouse.
	 	� Inserting Text – Inserting new content into your existing document is called inserting 

text. To insert the text, place the mouse pointer at the required position where you want 
to insert the text and click. Cursor (Insertion Point) appears on the screen to indicate the 
position where the inserted text will appear. You can now type the new text.

	 3.	� In Microsoft Word, spelling errors are marked with a red wavy line, while grammatical 
errors are shown with a blue double line.

C.	 1.	 Selecting text using the keyboard:
	 	 ●  To select a letter on the right or left side of the cursor 	 	 �Press Shift + Right/

Left arrow key
	 	 ●  	To select one line up or down				   	� Press Shift + Up/Down 

arrow key
	 	 ●  	To select a word on the right of the cursor  			   	� Press Ctrl + Shift + 

Right arrow key
	 	 ●  	To select a word on the left of the cursor 			   	� Press Ctrl + Shift + 

Left arrow key

3.

Æ

Æ

Æ

Æ
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	 	 ● 	 To select the entire document  			   	 Press Ctrl + A
	 2.	 To use the thesaurus, follow the given steps:
	 	 Step 1: Select the word.
	 	 Step 2: Click on the Review tab.
	 	 Step 3: Click on the Thesaurus tool.
	 	 Step 4: Click the down arrow and select Insert or Copy.

Higher Order Thinking Skills (HOTS)
1.	� To insert the text, place the mouse pointer at the required position where you want to insert 

the text and click. Cursor appears. You can now type the new text. It is useful to expand your 
document by adding extra text into your existing document.

2.	 Arun should use Cut and Paste commands to achieve this.

Digital Drills

	Do it yourself

 Formatting in Word 2021

Tech Trivia Section A (Objective)

A.	 1.	 c	 2.	 d	 3.	 a	 4.	 d
B.	 1.	 Change Case			   2.	 Paragraph spacing
	 3.	 Bold	 4.	 Home	 5.	 Text Effects

Answer Arcade Section B (Subjective)

A.	 1.	�	 Click on the Print Preview button on the Quick Access Toolbar to preview a document 
before printing it.	

	 2.	� The Change Case option in Word allows you to change the text to upper case, lower case 
or other common capitalizations.

	 3.	 The four alignment options available in Word – left, center, right, and justify.
B.	 1.	 To change the font, follow the given steps:
	 	 Step 1: Select the text.
	 	 Step 2: Click on the Home tab.
	 	 Step 3: Click on the drop-down arrow next to the Font box.

Æ

4.
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	 	 Step 4: Select the desired font.

	 	 To change the font size, follow the given steps:

	 	 	Step 1: Select the text.

	 	 Step 2: Click on the Home tab.

	 	 Step 3: Click on the drop-down arrow next to the Font Size.

	 	 Step 4: Select the desired font size.

	 2.	� A bullet is a small symbol, like a square or dot, used to indicate each item in a list. Whereas 
Numbering is used to number each item in a list.

	 3.	� Formatting the text involves changing its appearance and arrangement. You can format 
your text using the Font group in Word, like changing font, font size, font colour, font style, 
etc.

C.	  1.	 To print the document, follow the given steps:

	 	 Step 1: Click on the File tab.

	 	 Step 2: Select the Print option.

	 	 Step 3: Click the Print button. The document will be printed. 

	 2.	� Sudhir can use Highlighting feature, which involves marking important sections of text by 
applying a coloured rectangle over them, changes the background colour of the selected 
text.

Higher Order Thinking Skills (HOTS)
1.	� Formatting in Word 2021 is important because it makes professional documents look organised 

and attractive, enhancing readability and presentation.

2.	� The choice of alignment in a document makes it look neat and easy to read by arranging the 
text in a clear and organised way.

Code Clues

	 1.	 Ctrl + S
	 2.	 Font
	 3.	 Paragraph Spacing
	 4.	 Alignment
	 5.	 Hard copy

Digital Drills

	Do it yourself
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Worksheet 1
(Based on chapters 1 to 4)

A.	 1.	 External hard disk
	 2.	 CD Drive
	 3.	 Left Align
	 4.	 Redo
	 5.	 Start Button
	 6.	 Justify

B.	

ClockPinned Apps

Start Button 	

C.	 1.	 Text Effect
	 2.	 Bullet
	 3.	 Solid State Drive (SSD)
	 4.	 Icon
	 5.	 Byte
D.	      Home tab

Test Sheet 1
(Based on chapters 1 to 4)

(Section A)
A. 	 1.	 a	 2.	 d	 3.	 a
B. 	 1.	 Hard disk	 2.	 Microsoft Corporation	 3.	 Bold

(Section B)
A.	 1.	�	 Computer memory is where data and information are kept. The Central Processing Unit 

(CPU) gets data from memory to work on it.
	 2.	� Right-click on the taskbar, click on Taskbar settings. Scroll down to Taskbar behaviors, click 

on down-arrow. Select Left or Center option from Taskbar alignment down-arrow.
	 3.	� Position the cursor to the right of the text and press the Backspace key. The character to 

the left of the cursor will be deleted.
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B.	 1.	� Think of data as unprocessed, raw facts and figures, such as words, numbers, images, 
and symbols. Data by itself is meaningless. Once the data is processed and organised, it 
becomes information. Information gives a proper meaning.

	 2.	� You can adjust the speaker volume directly from the Taskbar. To do this, click on the speaker 
icon in the notification tray, then drag the slider left to decrease or right to increase the 
volume.

	 3.	 The four alignment options available in Word – left, center, right, and justify.

 The Internet—Web Browser

Tech Trivia Section A (Objective)

A.	 1.	 a	 2.	 d	 3.	 b	 4.	 b
B.	 1.	 International			   2.	 Website	 3.	 Search engine
	 4.	 Online			   5.	 ISP
C.	 1.	 T	 2.	 F	 3.	 T	 4.	 F

Answer Arcade Section B (Subjective)

A.	 1.	� The things required for having an Internet connection are a computer system, telephone 
and cable lines, modem, web browser, and ISP.	

	 2.	� A hyperlink is a special type of link on a website or document that takes you to another 
webpage or a different part of the same page when you click on it. 

	 3.	� Copilot refers to an AI-driven feature that provides appropriate assistance and enhances 
browsing experiences. 

	 4.	� Modem stands for Modulator-Demodulator. A modem converts digital information into 
analog signals for transmission over telephone lines and vice versa. 

B.	 1.	� Back/Forward: The back button helps you to navigate back to your previous page and 
forward button allows you to move forward again, if necessary.

	 	 Refresh : This button is used to refresh the page by reloading it from the Internet.
	 2.	� World Wibe Web: World Wide Web (WWW) is the largest collection of information in the 

form of websites on the Internet. The information can be a combination of text, graphics, 
audio, video, etc.

	 	� Internet: The Internet is a vast network that links millions of computers worldwide, enabling 
the sharing of information.

	 3.	� Web browser: A web browser is a software program that allows users to open and view 
various web pages. Examples of web browsers include Google Chrome, Microsoft Edge, 
Mozilla Firefox, etc.

5.
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	 	� Search engines: Search engines help users find specific information by scanning numerous 
web pages on the World Wide Web. A search engine is a software tool designed to locate 
particular information based on user queries. Examples of search engines are Google, Bing, 
Yahoo, etc.

C.	  1.	� The Internet is a vast network that links millions of computers worldwide, enabling the 
sharing of information. The things required for having an Internet connection are a computer 
system, telephone and cable lines, modem, web browser, and ISP.

	 2.	� The star icon (Favorites) on the Microsoft Edge window allows her to set a web page as a 
favourite or to add it to her reading list.

Higher Order Thinking Skills (HOTS)
1.	 Search engines
2.	� Being online gives quick access to lots of information and connects you with people worldwide, 

while being offline focuses on real-world, physical interactions and limited, local information.

Code Clues

1.	 INTERNET SERVICE PROVIDER
2.	 MICROSOFT EDGE
3.	 REFRESH

Digital Drills

	Do it yourself

 Introduction to PowerPoint 2021

Tech Trivia Section A (Objective)

A.	 1.	 a	 2.	 c	 3.	 d	 4.	 c
B.	 1.	 Close	 2.	 Slide Sorter	3.	 Status Bar	 4.	 Slides	 5.	 Slide Show
C.	 1.	 d	 2.	 a	 3.	 e	 4.	 b	 5.	 c

Answer Arcade Section B (Subjective)

A.	 1.	 A slide is a single page within a presentation.	
	 2.	� The slide layout refers to the arrangement of text, images, Cliparts, charts and other 

elements on a slide.

6.
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	 3.	 To start PowerPoint, follow the given steps:
	 	 Step 1: Type Powerpoint in Search box on the taskbar.
	 	 Step 2: Click on PowerPoint.
	 	 PowerPoint main screen will appear.
B.	 1.	 To delete a placeholder, follow the given steps:
	 	 Step 1: Select the placeholder by clicking its border.
	 	 Step 2: Press the Delete key.
	 2.	� The Quick Access Toolbar is located in the top left corner of the PowerPoint 2021 screen. 

This toolbar holds icons for features that are used often.
	 3.	 You can view your presentation in different views: 
	 	 ● 	 Normal View: It is the default view that allows you to create and modify slides. 
	 	 ●  �Outline View: It provides a view of the presentation’s outline structure and lets you edit 

the slides as well. 
	 	� ● � Slide Sorter View: It provides a view of all the slides in the presentation as thumbnails 

on a single screen. 
	 	� ● � Notes Page View: This view displays each slide with its corresponding notes below. 

It’s useful for adding speaker notes, helping you remember key points during your 
presentation. This layout is great for rehearsal and can also be printed for reference. 

	 	� ● � Reading View: It allows you to view a presentation not in full screen but in a window with 
simple controls that make the presentation easy to review. The ribbon and the slides/
outline pane are not visible.

C.	 1.	 To delete a slide Sahil should, follow the given steps:
	 	 Step 1: Right-click on the slide.
	 	 Step 2: Select Delete Slide option.
	 2.	� Comparison slide layout is suitable for this. To change the slide layout, follow the given 

steps:
	 	 Step 1: Click on the slide that you want to change.
	 	 Step 2: Click on the Home tab.
	 	 Step 3: Click on the Layout button.
	 	 Step 4: Select the desired slide layout.

Higher Order Thinking Skills (HOTS)
1.	� To prepare for a big presentation, practice speaking clearly, use simple and interesting slides, 

and make eye contact with the audience.
2.	� Astha can make her presentation more engaging by adding pictures, videos, animations, and 

using bright, easy-to-read text.
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Code Clues

	 1.	 Step 3	 2.	 Step 5	 3.	 Step 1	 4.	 Step 6
	 5.	 Step 2	 6.	 Step 4

Digital Drills

	Do it yourself

 Stepwise Thinking

Tech Trivia Section A (Objective)

A.	 1.	 a	 2.	 c	 3.	 b	 4.	 c
B.	 1.	 Solutions			 
	 2.	 Instructions
	 3.	 Reasoning			 
	 4.	 Problem Solving			
	 5.	 Time Table
C.	 1.	 T	 2.	 F	 3.	 F	 4.	 T	 5.	 F

Answer Arcade Section B (Subjective)

A.	 1.	� Reasoning is the process of analysing a task in a logical and clear manner, which helps in 
identifying the best choice among the available options. Problem Solving is the process 
of finding solutions to complex or difficult tasks.	

	 2.	� A case study is an examination based on a real-life scenario. In this process, you analyse 
the situation and address it using stepwise thinking.

B.	 1.	� Stepwise thinking, also known as computational thinking, involves ‘thinking like a computer’. 
A computer operates by following step-by-step instructions provided to it. This process 
of giving step-by-step instructions is referred to as programming.          

	 2.	 To plan to play badminton outside the home, follow the given steps:
	 	 Step 1: Find a suitable outdoor space.

7.
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	 	 Step 2: Gather equipment like rackets, shuttlecocks and a net.
	 	 Step 3: Ensure favourable conditions for the game.
	 	 Step 4: Invite your friends to play.
	 	 Step 5: Arrange the net and start the game.
C.	 1.	 Arrange your school bag according to the timetable with the help of stepwise thinking.
	 2.	� Tell your friend you made a mistake, apologise sincerely, and ask them to still come to 

your party.

Higher Order Thinking Skills (HOTS)
1.	 Program the robot to do things stepswise. For example:
	 Step 1: Pick up toys.
	 Step 2: Make the bed.
	 Step 3: Sweep the floor.
2.	� To balance multiple responsibilities, list them all and do one thing after another, like homework 

first, then play, then help with dinner.

Code Clues

7

4

13

1

15

Digital Drills

	Do it yourself
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 Features of File Management

Tech Trivia Section A (Objective)

A.	 1.	 b	 2.	 c	 3.	 d	 4.	 c	 5.	 a
B.	 1.	 Information	 2.	 Cabinet	 3.	 Password	 4.	 Original	
C.	 1.	 F	 2.	 T	 3.	 T	 4.	 T

Answer Arcade Section B (Subjective)

A.	 1.	� To protect your files from others, you should: 
	 	 ●  Keep your files hidden from others. 
	 	 ●  Set a password for your system and keep it confidential.	
	 2.	� A folder inside another folder is known as a subfolder. You can create multiple subfolders 

within a folder, and each of these can hold both files and additional subfolders.
	 3.	 When you copy a file, it stays in its original location and also appears in the new location.
B.	 1.	� ● � A file or folder holds important information. Opening someone else’s files and making 

changes without their permission is known as tampering. 
	 	 ● � Avoid tampering with others’ files or folders by changing their location or renaming them.
	 2.	 To move a file/folder, follow the given steps:
	 		  Step 1: Select the folder containing the file you want to move and open it.
	 		  Step 2: Select the file.
	 		  Step 3: Click on the Cut command.
	 		  Step 4: Select the new location where you want to paste your file and open it.
	 		  Step 5: Click on the Paste command.
	 3.	� When a file or folder is deleted, it goes to the Recycle Bin and stays there until it’s 

permanently removed. If needed, you can restore the files or folders from the Recycle Bin 
back to their original location. To restore a file or a folder, follow the given steps:

	 	 	 Step 1: Open the Recycle Bin. 
	 	 The Recycle Bin window will open, showing all the files you have deleted.
	 		  Step 2: Select the file.
	 	 	 Step 3: Click on the Restore the selected items option. 
	 	� The restored file or folder will be removed from the Recycle Bin and will reappear at its 

original location.
C.	 1.	 To move a file/folder Sahil should follow the given steps:
	 		  Step 1: Select the folder containing the file you want to move and open it.

8.
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	 		  Step 2: Select the file.
	 		  Step 3: Click on the Cut command.
	 		  Step 4: Select the new location where you want to paste your file and open it.
	 		  Step 5: Click on the Paste command.
	 2.	� Manya can organise her files by creating subfolders for each subject (like Math, Science, 

English) and placing related files inside them.

Higher Order Thinking Skills (HOTS)
1.	� When you create a new folder in Windows, it gets the default name “New Folder”. It can be 

difficult to remember the contents of a file with its default name. Windows allows you to 
rename files or folders to something more relevant, based on your own choice.

2.	� Garv can organise his desktop by creating folders based on file types or purposes, like 
Documents, Pictures, Music, Videos, and Downloads. He can then move similar files into the 
right folders to keep everything tidy and easy to find.

Code Clues

1.	 Folder
2.	 Recycle bin
3.	 Subfolder
4.	 Rename

Digital Drills

	Do it yourself

Worksheet 2
(Based on chapters 5 to 8)

A.	 1.	 b	 2.	 c	 3.	 d	 4.	 a
B.      	

Back/ 
Forward

Current Tab New Tab

Address Bar

Settings and more
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C.	 1.	 Problem Solving is the process of finding the solutions to a difficult task. 
	 2.	 A case study refers to a task that is based on real-life situations. 
	 3.	 A folder is like a cabinet in which you can keep your files. 
	 4.	 When a file or folder is deleted, it goes to the Recycle bin.

Test Sheet 2
(Based on chapters 5 to 8)

(Section A)

A. 	 1.	 b	 2.	 d	 3.	 c
B. 	 1.	 Online	 2.	 Slides	 3.	 Downloads

(Section B)
 
A.	 1.	� Copilot refers to an AI-driven feature that provides appropriate assistance and enhances 

browsing experiences. 
	 2.	� The slide layout refers to the arrangement of text, images, Cliparts, charts and other 

elements on a slide.
	 3.	 To protect your files from others, you should: 
	 	 ●  Keep your files hidden from others. 
	 	 ●  Set a password for your system and keep it confidential.
B.	 1.	� World Wibe Web: World Wide Web (WWW) is the largest collection of information in the 

form of websites on the Internet. The information can be a combination of text, graphics, 
audio, video, etc.

	 	� Internet: The Internet is a vast network that links millions of computers worldwide, enabling 
the sharing of information.

	 2.	 To delete a placeholder, follow the given steps:
	 	 Step 1: Select the placeholder by clicking its border.
	 	 Step 2: Press the Delete key.
	 3.	 To move a file/folder, follow the given steps:
	 	 Step 1: Select the folder containing the file you want to move and open it.
	 	 Step 2: Select the file.
	 	 Step 3: Click on the Cut command.
	 	 Step 4: Select the new location where you want to paste your file and open it.
	 	 Step 5: Click on the Paste command.


